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Standing in the high school 
hallway, they seem an odd 
match to the other students. 
She is cool and hip, 
and she already has 
a date to the prom. 
He is awkward and 
unfashionable—he 
wears high-water 
pants and from his 
shirt pocket pro-
trudes a pocket pro-
tector. To us, they 
are the perfect 
characters for one 
of two mu ltimedia 
presentations in-
tended to teach 
high school stu-
dents about tech-
nical communication and a 
technical writing competition. 

In this article, we chronicle 
our journey into the realm of 
multimedia, from our efforts to 
obtain funding for these pres-
entations, to our efforts to 
design communication prod-
ucts that would appeal to 
high school students. At the 

end of the article, we discuss 
some of the lessons we learned 
along the way. 

Reaching Out 

Our interest in creating multime-
dia presentations is rooted in 
outreach. Professional and edu-
cational outreach strengthens 
the relationships between STC 
chapters and their local commu-
nities. The strengthening of 
these relationships is essential 
to the future of the technical 
communication field. The more 

actively STC chapters inter-
act with local industry and 
educational institutions, the 

more we are 
seen as an es-
sential part of 
our communi-
ties’ prosperity. 
Not to mention 
that in the proc-
ess we get to 
recruit some of 
the brightest 
students to our 
profession. 

The Orlando 
STC Chapter 
has made a 
concerted ef-

fort over the past seven 
years to reach out to high 
school students. In 1996, our 
chapter launched its annual 
high school technical writing 
competition. To recruit en-
tries for the competition rep-
resentatives from our chap-
ter’s Education Committee 
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(Continued from page 1) 
made classroom visits to local high 
schools to describe the field of tech-
nical communication and promote the 
writing com-
petition. 

Anyone who 
has stood 
before an 
audience of 
high school 
students 
appreciates 
the chal-
lenge of capturing and maintaining 
their attention. At times, it seems their 
eyes shut faster than your words can 
reach their ears. So, our chapter’s 
Education Committee proposed that 
classroom visits by committee mem-
bers could better reach the student 
audiences by employing a high-tech 
example of technical communica-
tion—a product that would personify 
and exemplify the profession. 

Lining Up the Money 

Such products do not come cheap—
not in the commercial world, at least.  
Even in the world of volunteerism and 
professional associations, a project of 
this magnitude was well beyond the 
budget of our local chapter.  Deter-

At times, it seems 

their eyes shut faster 

than your words can 

reach their ears.  
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mined to find the resources to pursue the 
project, Dan Jones at UCF and Dan Voss, 
manager of our chapter’s Education Com-
mittee, submitted a proposal to the STC 
Special Opportunities Grant Committee in  
the fall of 2001.  The merits of the proposal 
were acknowledged, but the awarding of a 
grant was delayed due to funding con-
straints.  Finally, in the spring of 2002, the 
“Dan and Dan” duo received notice that 
the project had been awarded a grant with a 
budget of $8,000.  We were finally ready to 
make our vision a reality. 

Deciding on Multimedia  

A quick look at recent music videos and 
the latest Vin Die-
sel movie told us 
that if we wanted 
to capture and 
hold the attention 
of our young audi-
ence, the presenta-
tions had to be 
high impact—
maybe even in-
clude an explo-
sion, which we were, in fact, later able to 
work into one of the presentations. We 
decided that the best way to make the pres-
entations high impact would be by integrat-
ing audio, animation, movie clips, and text 
in a multimedia presentation. 

The program of choice was Authorware, 
which could accommodate all these effects 
and generate an easily downloadable self-
executing file with multi-platform capabil-
ity—and for which Dan J was able to se-
cure a fully functional software package at 
a special educational price of $380—
representing a whopping 86% savings over 
the manufacturer’s retail price of $2,700.  
We purchased two copies so the two pres-
entations could be developed independ-
ently. Software in hand, we were ready to 
go. 

Overcoming the Challenges  

One of the foremost challenges we con-
fronted was how to appeal to our audience. 
We knew the presentation had to “pop,” 
but what, exactly, “pops” with 14- to 18-
year-olds? 

Early in the development process, Dan 
Voss recommended using two high school 
students as the central characters for the 
“What’s Technical Communication?” pres-
entation. Based on this idea, we decided to 
create a dialogue between two high school 

seniors, Shanna 
and Dan, as the 
vehicle for our 
tutorial. 

Here’s the 
catch. Shanna, 
the “cool” char-
acter, is an as-
piring technical 
communicator. 
Dan, the 

“geeky” character, hasn’t heard about the 
field of technical communication, but will 
listen intently to anything Shanna has to 
say, because he obviously has a crush on 
her, hopeless though it may be. Through-
out the presentation, Shanna plays the role 
of a tour guide, leading Dan through the 
ins and outs of technical communication. 

The “cool-versus-geek” motif was intended 
to dispel the perception that technical com-
municators are intrinsically “uncool,” like 
“Tina the Brittle Technical Communicator” 
who Scott Adams made famous in the Dil-
bert strip.  A primary objective of the edu-
cational outreach is to show students that 
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We knew the 

presentation had to 

“pop,” but what, 

exactly, “pops” with 

14- to 18-year-olds?  

… too much of any 

one thing in a 

classroom is a recipe 

for sleep.  

To enliven their multimedia tutorial 
on technical communication, the 
research assistants in the Orlando 
Chapter’s STC Special Opportunities 
Grant project breathed life into a 
pair of animated high school charac-
ters at opposite ends of the social 
spectrum:  Shanna the Hip and Dan 
the Nerd. 

As a motif for the promotional on the 
chapter’s annual high school tech writ-
ing competition, the designers se-
lected the perfect backdrop for Central 
Florida—the space program. 
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(Continued from page 2) 
there is a bright future in the technical communication field, and 
we felt that our audience would relate to Shanna as a shining 
example of the opportunities our profession presents for tal-
ented and “cool” young people.  

For the “Florida High School Writing Competition,” we decided 
to use a space theme. This was, in part, a practical decision. 
Since the NASA space image and audio files are in the public 
domain, we would not have to obtain copyright permissions. 
The space theme also added a local flavor to the presentation. 
A number of our chapter members work for the space and aero-

nautics industry, and nearly all of 
us have experienced the incompa-
rable grandeur of a night launch 
from nearby Cape Kennedy. 

The space theme helped set a 
more serious tone that deliberately 
contrasted the more playful tone 
of the “What’s Technical Commu-
nication?” presentation. The 
counterpoint was intended to help 
keep our audience’s attention. 
Anyone who has taught high 

school students will tell you, too much of any one thing in a 
classroom is a recipe for sleep.  

Organizing Our Presentations 

To set our plan of creating informative, yet entertaining, presen-
tations into motion we began by creating storyboards of the 
presentations. Our storyboards were large index cards contain-
ing the tentative text and sample characters—one for each 
screen in the presentations. We laid out the cards for each pres-
entation and, in collaboration with our advisors, we switched 
the order of several cards, penciled in new details, and added 
cards where necessary.  

After editing the content and arrangement of the information for 
the two presentations, we submitted the storyboards to the 
manager of the STC Special Opportunities Grant Committee, 
Deborah Rosenquist, and the manager of the STC Branding 
Committee, Mary Wise, for their review.  Their encouraging 
response to our ideas allowed us to breathe a sigh of relief. We 
received several constructive suggestions from them, including 
the recommendation that we add a module on information de-
sign to the discussion of technical communication. 

While the storyboards were going through the review process, 
we set out to learn Authorware, which is quite different from the 
software applications we had used in the past. Authorware re-
lies on users selecting and placing icons along a continuum 
that resembles a vertical timeline. Each icon represents a 
“chunk” of information, so to speak. For example, one icon may 
represent the text and images for a screen, a second may repre-

sent the sound that accompanies that screen, and a third may 
represent a pause in the screen’s transition to the next screen. 
One of the challenges of learning Authorware was remembering 
what each icon represents. Icons are unforgiving.  One slight 
disarrangement and you may be laughing or crying at what you 
suddenly see on the screen.  

Putting the Presentations to the Test 

After long hours of burning the midnight oil wrestling with 
Authorware, we created beta versions of each presentation. 
Then we arrived at the moment of truth.  We tested the beta 
versions of the two presentations with Lake Brantley High 
School students in Longwood, Florida, to gather students’ re-
actions toward the themes and narrative characters. 

The students approved of the overall quality and content of the 
material. For “What’s Technical Communication,” we were par-
ticularly interested in the students’ reception of Dan’s squawky 
voice and nerdy personality. Throughout the presentation, the 
students laughed at Dan’s awkward speech cadence, leading to 
high approval ratings.  

The students also responded favorably to the space theme for 
the “Florida High School Writing Competition.” 

While the testing validated our basic approach, it also revealed 
several shortcomings in the second presentation. For example, 
when projected on a large screen, the typography became un-
readable due to inadequate type size and contrast between type 
and background. Also, sections of the presentation lacked suf-
ficient audio.  Particularly noticeable in comparison to the other 
presentation was the absence of a narrative voice-over. 

Fine-Tuning the Product 

We made changes to both presentations based on what we 
learned from the students. We increased the type size, beefed 
up the graphics, and added a 
narrative voice-over to the 
“Florida High School Writing 
Competition.  We also added 
an interactive menu to the 
“What’s Technical Communi-
cation?” presentation, to al-
low teachers or chapter mem-
bers visiting high school 
classes to pick and choose 
among the several modules 
of information on technical 
communication.  We wanted 
the presentation to provide a 
comprehensive view of our 
profession, but we were also 
mindful of the need to build 
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…we were particularly 

interested in the 

students’ reception of 

Dan’s squawky voice 

and nerdy personality. 

The moment of truth for the 
grant project came during beta 
testing with a live audience at 
Lake Brantley High School.  
Not everything was perfect, of 
course, but at the end of the 
day, the team knew it had a winner. 
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in the ability to focus on se-
lected areas and to truncate 
the presentation if necessary 
due to time constraints or 
waning audience interest. 

With improved versions of the 
presentations we conducted a 
second usability test. This 
time our audience was stu-
dents in a technical communi-
cation class at the University 
of Central Florida. While it 
was not exactly the same as 
our target audience, we felt 
that this audience would be 
more critical of our content 
and perhaps better qualified to 
reveal potential organizational 
weaknesses. Besides, Dr. 
Jones spent a few minutes at 
the beginning of the class 
helping his college students 
regress, at least temporarily, 
back to their high school 
years. 

We distributed surveys with a 
free-response section to the 
students before showing the 
presentation. Overall, this 
audience was also very recep-
tive to our presentations. 
Some students indicated that 
they learned something new 
about technical communica-
tion from the presentations.  

The college students found 
the “Florida High School Writ-
ing Competition” both read-
able and engaging with the 
voice-over, easily readable 
type, and more graphics. 
When we surveyed the stu-
dents’ opinions of Shanna 
and Dan we received a mixed 
response. Some students felt 
that Dan’s voice was too abra-
sive for the presentation, 
while other students gave him 
the most favorable rating.  

Wrapping It Up 

Now approaching the final 
draft of “What’s Technical 
Communication?” we decided 
to keep Dan. Whether the stu-
dents loved him or hated him, 
he definitely helped maintain 
their attention, which, as you 
may recall, was our primary 

challenge in communicating 
with high school students. 

The college students’ re-
sponses indicated that we did-
n’t need to make sweeping 
changes to the content or or-
ganization of the presenta-
tions. So, to complete our final 
versions we simply made small 
changes to the presentations 
based on the way the design 
elements appeared when dis-
played on the large screen.  

Learning from the Experience  

As with any project, we 
learned a great deal by working 
on this project. Like many 
technical communicators, we 
had not worked on a multime-
dia project before. This project 
offered us the opportunity to 
dig into this medium and learn 
a new software application, as 
well as many lessons about 
developing multimedia presen-
tations. The following are a 
few of the insights we gained 
about multimedia projects:  

• Anticipate a learning 
curve for the new soft-
ware. 

• Expect technical prob-
lems. 

• Prepare for the project to 
take time—many months 
at the very least. 

• Create storyboards to 
hammer out the narrative 
early. 

• Use iterative testing 
throughout the project. 

Above all, working on this 
project compelled us to face 
the central challenge of any 
technical communicator—
know and reach one’s audi-
ence! 

We also learned that one of 
the best ways to make out-
reach successful is to portray 
technical communication as 
precisely the exciting and dy-
namic field that it is. And what 
better way for us to do this 
than to practice what we 
preach? Consider our audi-
ence, write clearly and con-
cisely, and design for the user.  
We believe we did this, and 
that’s why our project suc-
ceeded. 

Epilogue 

At the end of the “What’s 
Technical Communication?” 
presentation, Dan finally mu s-
ters the nerve to ask Shanna 
for a date.  Without missing a 
beat, our resourceful heroine 
comes up with the perfect al-
ibi—she has to attend an STC 
meeting! 
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Check Out Our  
Presentations Online! 

 

If you really want to get the 
“sizzle,” you need to check out 
the STC grant team’s work on-
line, in living color and multime-
dia.  You need to meet Shanna 
and Dan up close and personal! 

You should soon be able to 
download both presentations at 
the STC Web Site. We made 
every effort to streamline file 
sizes to make this a realistic op-
tion.  However, if your platform 
does not permit you to down-
load this material, you may con-
tact Jon Kessler of the Orlando 
Chapter, coordinator of its an-
nual high school tech writing 
contest, at jskessler@aol.com, 
and he will mail you a CD con-
taining the executable files for 
both presentations. 

The “What’s Technical Communi-
cation” presentation is turnkey-
ready to use with high school 
classes.  The “Florida High 
School Writing Competition” 
presentation can readily be 
adapted to support an existing 
writing competition that your 
chapter sponsors or one that you 
are about to initiate.  If you 
need the Authorware source files 
to support such an adaptation, 
please contact Jon Kessler and 
he will arrange a suitable elec-
tronic exchange. 

mailto:jskessler@aol.com,
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It’s seven o’clock on a Saturday morning and the last thing I 
want to do is wake up, but I know I have to.  Today is no dif-
ferent than the last six Saturdays, and besides, I have been 
telling myself that I need to learn 
HTML for the past two years.  This is 
my chance.  It’s free, it’s not intimidat-
ing, and it only lasts from 10-11:30 a.m. 

Bribing myself with the memory of last 
Saturday’s fresh Panera bagels, I drag 
myself out of bed and get ready to fi-
nally learn the basics of HTML at this 
morning’s Future Technical Communi-
cators (FTC) workshop at UCF.  Fortu-
nately, autopilot kicks in, and I arrive at 
UCF’s technical writing lab without 
even having to think about it.  As I lug 
the 12-pack of Pepsi up the stairs, I 
realize that Kevin and Bob are al-
ready there.  Usually, I get to the 
lab around 9:15 to unlock the 
doors and set up the refreshments, 
but it was Bob’s turn to buy the 
bagels today.    

Shortly after I arrive, several sleepy UCF students and a few 
bright-eyed UCF employees file in.  I knew that HTML would 
be a popular workshop.  I feel proud for a moment that we 
were able to offer a mini Web designing series, and then hope 

that next week’s FTP workshop 
is as popular.  Only ten people 
e-mailed me to register, but by 
now I’ve learned that pre-
registration isn’t a true indicator 
of how many people will actu-
ally come.  Before I formally in-
troduce today’s leader, I make 
sure that everyone has signed 
in.  Twelve people.  Not bad for 
the end of the semester.  It 
seems like the people who sin-
cerely want to learn come re-

gardless of the date.  

After introducing myself, I drop in a couple of plugs for FTC 
and explain to the group that we are students teaching other 
students as a way to give something back to our educational 
community, an idea born several years ago by Bob Whitley.  I 
give the standard disclaimer that we are by no means 
“experts” in the programs we teach, but rather we are sharing 
the knowledge we have.  Even though Sonia and Kevin are 
extremely proficient in HTML, I say it to make the point that 

Pepsi, Bagels, and HTML 

FTC Club Gets Up Early on Saturdays to Hone Tool Skills 
by Bonnie Spivey,  President, UCF Future Technical Communicators Club 
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this is an informal, no-cost, voluntary exchange of information.  I 
also inform everyone that Kevin will be walking around to help any-
one who has questions.  I encourage the guests to take advantage of 

the bagels and sodas and then turn the 
floor over to Sonia.   

Sonia is a student in one of my classes, 
as well as a member of FTC.  Like all the 
students who teach our workshops, she 
has bravely volunteered.  At our first 
official FTC meeting earlier in the semes-
ter, I presented the idea of hosting free 
technical communication workshops, 
and to my surprise, I was overwhelmed 
with volunteers.  Kerri, next Saturday’s 
FTP leader, had never FTP’d anything 
before she took on the challenge and 
forced herself to learn it. 

This has been the case with several 
students.  For instance, Meghan 
taught our first workshop, basics of 
PowerPoint, after writing down in-
structions while learning the pro-
gram.  On the other hand, Kevin 

taught a workshop on Authorware based on the tutorial he produced 
using it last summer during an internship.  But whether it was taught 
by an expert or a novice, I must say that each workshop has been 
first-rate.   

While our beginning workshops are 
designed to familiarize people with the 
basics of the programs, other work-
shops, like Adobe PageMaker, have 
been more complex.  Some workshops, 
like the Word: MLA Formatting class 
that Jou-Ying taught on Saturday, April 
5th, focus on helping the attendees com-
plete a required task.  In this instance, 
those who registered were asked to 
bring their research papers in on disk.  
This way, students were able to apply 
what they learned directly to their projects.  It’s surprising how many 
people didn’t know how to insert headers or use the outline function 
in Microsoft Word, a standard in almost any industry. 

On April 12th, a student that I recruited after he generously shared 
his expertise with Kevin and me during open lab hours, conducted a 
very comprehensive workshop on Adobe PhotoShop.  After cover-
ing the basics and walking the group through a simple, informative 

(Continued on page 6) 

Having recently taught herself PowerPoint, Meghan 
Flick shares some tips with Elizabeth, Sandy, and Jen 
at a Saturday tool skill workshop at UCF sponsored by 
the Future Technical Communicators.  

… we are by no means 

“experts” in the 

programs we teach, but 

rather we are sharing 

the knowledge we 

have.  

FTC [invites] STC 

Orlando Chapter 

members who are 

interested in attending 

or presenting at our 

tool skill workshops. 
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Collect the Complete Set! 

Word Mint IV: A Juicy Tidbit from the World of Aerospace Contracts 
by Dan Voss  

Post-Definitization (adj or adv, depend-
ing on usage).  Occurring in the period 
following contract definitization; not to 
be confused with “after contract defini-
tion” (a colloquial usage, considered 
sub-standard in educated circles).  Root 
word is definitize (v.), which means “to 
define more precisely,” as opposed to 
regular “defining” (colloquial; see 
above).  In popular aerospace usage, 
non-frock-wearing mortals “define” con-
tracts, but anointed contractual special-
ists must be called in to “definitize,” 
them, which, of course, results in their 

definitization.  Whence the reference to the 
ensuing contractual period as “post-
definitization” (formerly referred to as “being 
under contract”).  The derivation of the term 
“post-definitization” bears certain similarities 
to that of co-equal, which is a more emphatic 
form of “equal” meaning “more equal.” And to 
pre-warn , which is a more emphatic form of 
“warn” used in situations calling for particu-
larly intense levels of admonition.  (Whether or 
not the existence of the term “pre-warn” im-
plies the existence of the complementary term 
post-warn  has been the subject of intense de-
bate amongst linguistic scholars for decades.)  

Examples:  (1) The Contracts team 
called a post-definitization (adj) party 
at Harry and Marsha’s café after nego-
tiations were complete.  (2) Did your 
Contracts manager quit pre- or post-
definitization (adv)? (3) We are not 
under contract yet, but we are pro-
ceeding with work under an Undefini-
tized Contract Action (UCA).* 

*  There actually is such a term and 
such an acronym.  I swear.  If you 
don’t believe www.acronymfinder.com, 
you can ask an aerospace Contracts 
expert. 

(Continued from page 5) 
exercise, Jody fielded any specific ques-
tions people had, solving several technical 
mysteries in the process.  

Aside from our successful series of work-
shops, FTC has also focused on increasing 
the UCF presence at meetings of the local 
STC Orlando Chapter.  Having attended a 
local STC meeting last semester, I wanted 
to see more UCF students taking advan-
tage of the opportunity.  In fact, more than 
20 students from FTC attended the first 
STC meeting of 2003 and signed up for the 
discounted student memberships—which, 
by the way, we all greatly appreciate! 

Though many students were aware that 
STC existed, most of them were intimidated 
by the expectation that they would be 
“overmatched” in experience and expertise 
and were therefore hesitant to go to the 
meetings.  After making participation in 
STC a central part of our FTC mission 
statement, giving my very convincing pep 
talks (J), and coordinating car-pooling ar-
rangements, I am pleased to report that 
these efforts, not to mention sheer strength 
in numbers, have allowed FTC to become a 
conduit to STC.   

After successfully piloting our workshops, 

FTC would now like to extend an invitation 
to any STC Chapter members who are inter-
ested in attending or presenting at these 
sessions.  We are open to suggestions 
concerning the content of the workshops. 

The next FTC workshop, focusing on ad-
vanced Power Point, is scheduled for Sat-
urday, May 17th, at the UCF tech writing 
lab (Colbourne Hall, Room 203).  To regis-
ter, contact me at futuretek2003@hotmail.
com.  We hope to strengthen the long-
standing partnership between the techni-
cal communication program at UCF and 
the Orlando STC Chapter. 

FTC plans to continue to host the free 
technical communication workshops 
throughout the summer and the following 
school year.  We hope to leave behind a 
successful, constructive legacy of teach-
ing and learning together that continues 
long after we turn our technical communi-
cation tassels.  We invite the Orlando 
Chapter to be our partners in this en-
deavor.   

To learn more about FTC or our work-
shops, please visit our fledgling website at 
pegasus.cc.ucf.edu/~ftech or e-mail me at 
futuretek2003@hotmail.com.   

The newest member of our chapter’s 
Education Committee, Bonnie Spivey, 
has been working to strengthen our 
chapter’s long-standing partnership with 
the technical communication program at 
UCF. 

 

http://pegasus.cc.ucf.edu/~ftech/
mailto:futuretek2003@hotmail.com
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Two More Reasons to Visit the Orlando Chapter STC Web Site  
by Mike Murray, Chapter President 

color copies for your friends and coworkers. The brochure is 
also a great resource for current members who would benefit 
from an overview of STC and the Orlando Chapter.  

In the panels of the brochure, you’ll find 

• Information about the Society for Technical Communication 

• Details about some of the professional development oppor-
tunities available through the Orlando Chapter 

• An explanation of how technical communications includes 
more than just writers 

• Some of the broad cross-section of Central Florida comp a-
nies represented by our members 

• Ways you can get involved in chapter activities  

• Membership fees and how to join 

The Chapter Strategic plan and Information Brochure and just 
two more reasons to visit the Orlando Chapter Web site. Please 
let us know what els e we can do to add value to your visit. 

If you haven’t visited the Orlando Chapter’s Web site re-
cently, it’s definitely time to take another look! You only have 
to go as far as the Home page at www.stc-orlando.org to see 
some prominent new additions that are worth looking over. 

Strategic Plan 

Select the “here” link in the colorful “Strategic Plan” box on 
the right side of the page to see what the chapter leadership 
has in mind through 2007. You’ll find major objectives in the 
areas of membership, education, member employment opportu-
nities, instructional outreach, Web site enhancements, promo-
tions, and more. Specific strategies establish areas of focus for 
achieving these objectives as we work toward our mission of 
“Designing the future of technical communication in Central 
Florida.” 

Chapter Information Brochure 

Do you know someone who you think would benefit from 
membership in STC? The new chapter information brochure is 
now available on our home page. Again, just look for the col-
orful “Prospective Members” box on the right side of the page 
and select the “brochure” link to download and print a few 

March Meeting: Are you a Doormat or a Solution Architect? 
by David Coverston 

Are you a doormat or a solution architect? A Tina or a Xena? 
Which would you rather be? If you missed our last meeting, 
then you missed an excellent presentation by two of our own 
members that contained a recipe for transformation. In From 
Tina to Xena: A Recipe for Professional Empowerment Dan 
Voss and W.C. Wiese gave us a number of tips that could 
change you from a wimpy cartoon technical writer into a vixen 
of the screen. This topic was presented in Nashville, Tennes-
see at the 49th International STC Conference in May of 2002. 

Here are some of the guidelines: 

• Dress for success. Even thought casual business dress is 
in vogue now, you do not want to be the messiest dresser 
in your company.  

• Use first names. When you meet co-workers in the hall-
ways at work, use their first names. If everyone else is 
talking to “Fred,” you don’t want to be talking to “Mr. 
Smith.”  

• Form alliances.  Build relationships with other vital 
groups in your company such as the IT people, marketing, 
and management. 

Tactical operations you should conduct as part of your strategic 
process include having a treatment conference, a production con-
ference and tracking the job. At the treatment conference you 
should assemble all the people who have a vested interest in your 
project, and identify your communication objectives. Likewise at 
your production conference you should assemble all involved 
communication specialists and devise your multimedia communi-
cation plan to achieve your objectives. When you track the job, 
meet weekly to coordinate activities and discuss any problem ar-
eas. 

Notes on this presentation are on our chapter’s web site at www.
stc-orlando.org/prodev/49notes/TinaXena.asp. 

After the presentation, we split into four groups to practice prob-
lem solving as a group. We were given a scenario, and were 
tasked with developing an integrated communication plan to re-
solve the challenge presented in the scenario. This was a lot of 
fun and was a great opportunity to get to know other STC mem-
bers.  

http://www.stc-orlando.org/
http://www.stc-orlando.org/prodev/49notes/TinaXena.asp
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Often I need to find something in a Word document, 
and I am grateful for the tools Word provides. Each tool 
has its own strengths, so matching the tool to what I am 
trying to find is an important part of my search.  

When I want to find a table or a graphic, I reach for the 
Object Browser tool first (Figure 1).  

 

 

 

 

 

 

 

 

Many writers are not familiar with this great tool. It sits 
unobtrusively at the bottom of the vertical scroll bar. 
Click the round button in the middle to open the Object 
Browser menu (Figure 2). 

 

 

 

 

 

 

 

Place your pointer over any of the icons and the Tool 
tip pane at the bottom of the menu shows you the 
tool’s function. In Figure 2, I am pointing to the 
Browse by  Graphic tool. Click the icon and Word takes 
you to the first graphic in the document. After you find 
a graphic, the double-arrows on the Object Browser tool 
turn blue. Clicking the blue down double-arrow takes 
you to the next graphic in the document; clicking the up 
double-arrow takes you to the previous graphic (unless 
you are at the first graphic, of course). The settings for 
this tool are sticky, meaning that the tool “remembers” 
the last object you found, so you don’t have to open 
the menu each time to choose the object you want to 
search for. This also works for text searches you have 
done using the Find and Replace tool. You can close 
the Find and Replace dialog box altotgether and just 
click the blue double-arrows to find the next occurrence 
of your text. 
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Figure 1: Object 
Browser Tool 

Figure 2: Opening the 
Browser 

Figure 3: Find Tool 

Tool Tips: Advanced Find in Word 
by David Coverston 

The next tool Word provides for searching is the Find tool 
(Figure 3), but this tool is buried so deep even fewer users know 
about it. It is quite different than the Find and Replace tool which 
is accessed by pressing Control+F (my favorite method) or by 
choosing Edit > Find from the main menu.  

To use the Find tool, you have to choose File > Open on the main 
menu, then click the Tools drop-down arrow on the Open dialog 
box, and choose Find. This opens the Find dialog box. Go ahead; 
you’ll see the difference between the two tools immediately.   

The Find tool lets you search for files by name, for text in a file, for text 
in comments, by author, by number of characters/paragraphs/pages, by 
date, and even by template. By clicking the Add toList button, you can 
build a search for a number of different criteria.  
For example, you can look for any file, written by David, in the last 
month, containing the text mushroom recipe.Whew, more than you ever 
thought of.  
In contradistinction to the previous two tools, the Find and Replace dia-
log is probably the most commonly used tool in Word. I have watched 
many a writer open the Find and Replace dialog box, type in a search 
term, click the Find Next button, and away they go… to nowhere. Just 
one wrong character will do it. I confess– I have fat fingers, so I found 
an easier way. You may have noticed that you can’t copy text and use 
the Paste tool to paste text in, and right-clicking to bring up a context 
menu doesn’t offer a way to paste your string of text either. But Con-
trol+V works in the dialog box. 
With all these tools, you might think I would be satisfied. Not so. Some-
times I want to copy a string to the clipboard, but then find something 
different and paste the contents of the clipboard near the text I want to 

(Continued on page 9) 
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So open your Visual Basic editor and enter the following 
code: 
 
Public Sub FindNextOccur() 
'' Set Shortcut key to 
Cntrl+Alt+DownArrow 
 
Dim SelectWord As String 
Dim msgText As String 
Dim msgText2 As String 
Dim msgButtons As Integer 
Dim msgTitle As String 
 
msgText = "Please select a word or 
phrase." 
msgText2 = "No more occurences in this 
document." 
msgButtons = 0 
msgTitle = "Dave's Fast Find" 
 
If Selection.Type <> wdSelectionNormal 
Then 
            Rsponse = MsgBox(msgText, 
msgButtons, msgTitle) 
            Exit Sub 
Else 
    SelectWord = Selection.Text 
    Selection.Collapse Direction:
=wdCollapseEnd 
    Selection.Find.ClearFormatting 
    With Selection.Find 
        .Text = SelectWord 
        .Replacement.Text = "" 
        .Forward = True 
        .Wrap = wdFindStop 

        .Format = False 
        .MatchCase = False 
        .MatchWholeWord = False 
        .MatchWildcards = False 
        .MatchSoundsLike = False 
        .MatchAllWordForms = False 
    End With 
    Selection.Find.Execute 
    If Selection.Find.Found = False Then 
        Rsponse = MsgBox(msgText2, 
msgButtons, msgTitle) 
 
''Back up to and select the last occur-
rence 
 
    Selection.Find.ClearFormatting 
    With Selection.Find 
        .Text = SelectWord 
        .Replacement.Text = "" 
        .Forward = False 
        .Wrap = wdFindStop 
        .Format = False 
        .MatchCase = False 
        .MatchWholeWord = False 
        .MatchWildcards = False 
        .MatchSoundsLike = False 
        .MatchAllWordForms = False 
    End With 
    Selection.Find.Execute 
 
    End If 
End If 
 
End Sub 
 
 
 
Complete Customization 
To complete your customization, set a shortcut key combina-
tion to run the macro. Choose Tools > Customize, then click 
the Keyboard button to open the Customize dialog box. 
Choose Macros in the Categories list, and FindNextOccur in 
the Macros list. Click in the Press new shortcut key text box 
and press Control+Alt+Down arrow key, then click Assign 
and Close twice to return to your document. 
Now enter the following code for the Find Previous Occur-
rence macro, and customize your keyboard to use Con-
trol+Alt+Up arrow to run it. There you are– a new tool to find 
text with. Enjoy! 

(Continued on page 10) 

(Continued from page 8) 
find. Or, sometimes I want to know if a phrase appears 
above or below my current position in the document, and I 
want a fast way to find it. So I wrote  “Dave’s Fast Find” to 
do this for me. All I have to do is highlight a word or phrase, 
and press my hot keys to find a occurrence of the high-
lighted phrase. I have a hot key for the next occurrence and 
one for the previous occurrence. If the macro finds a match, 
then the highlight moves to that occurrence; if it doesn’t, 
then a message box tells me there is not another occurrence 
in the direction I am searching and my phrase remains high-
lighted. If I have not highlighted a word or phrase, then a 
message tells me to select a word or phrase. 

Tool Tips Cont’d 
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(Continued from page 9) 
 
Public Sub FindPrevOccur() 
''Set Shortcut key to Control+Alt+UpArrow 
Dim SelectWord As String 
Dim msgText As String 
Dim msgText2 As String 
Dim msgButtons As Integer 
Dim msgTitle As String 
 
msgText = "Please select a word or phrase." 
msgText2 = "No Previous occurences in this 
document." 
msgButtons = 0 
msgTitle = "Dave's Fast Find" 
 
 
If Selection.Type <> wdSelectionNormal Then 
            Rsponse = MsgBox(msgText, msgBut-
tons, msgTitle) 
            Exit Sub 
Else 
    SelectWord = Selection.Text 
    Selection.Collapse Direction:
=wdCollapseStart 
    Selection.Find.ClearFormatting 
    With Selection.Find 
        .Text = SelectWord 
        .Replacement.Text = "" 
        .Forward = False 
        .Wrap = wdFindStop 
        .Format = False 
        .MatchCase = False 
        .MatchWholeWord = False 
        .MatchWildcards = False 
        .MatchSoundsLike = False 
        .MatchAllWordForms = False 
    End With 
    Selection.Find.Execute 
    If Selection.Find.Found = False Then 
        Rsponse = MsgBox(msgText2, msgButtons, 
msgTitle) 
''Back to the last occurrence 
 
    Selection.Find.ClearFormatting 
    With Selection.Find 
        .Text = SelectWord 
        .Replacement.Text = "" 
        .Forward = True 
        .Wrap = wdFindStop 
        .Format = False 
        .MatchCase = False 

        .MatchWholeWord = False 
        .MatchWildcards = False 
        .MatchSoundsLike = False 
        .MatchAllWordForms = False 
    End With 
    Selection.Find.Execute 
 
    End If 
 
End If 
 
End Sub 
 
 
David Coverston, Orlando Chapter secretary, is a techni-
calwriterfor PaySys International, Inc. If you have any 
questionsabout this Tool Tips article, please feel free to 
contactDavid at dcoverston@paysys.com. 

Tool Tips Cont’d 

mailto:dcoverston@paysys.com
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An informative and far-ranging progres-
sion about how to enhance one’s pros-
pects for job placement or career ad-
vancement in technical communication 
will be the main event at this month’s 
chapter meeting, scheduled for 6:30 p.m. 
Tuesday, April 22, at the Winter Park 
Civic Center. 

Another highlight of the evening will be 
the presentation of this year’s Melissa 
Pellegrin Memorial Scholarships to the 
most outstanding undergraduate and 
graduate students in the University of 
Central Florida technical communication 
program who applied for the coveted 
award that honors the memory of the 
1994 graduate and Orlando Chapter mem-

ber. 

With its focus on job search and place-
ment, the meeting has much to offer both 
to the chapter’s strong contingent of UCF 
students, many of whom will soon be en-
tering the job market, and to professionals 
who are looking to move up a rung or two 
on the career ladder—or perhaps to get 
back on it after a short detour thanks to 
the recession! 

The progression format will consist of 
seven round-table presentations exploring 
a wide range of topics pertaining to job 
search and placement (see table). 

There will be four 20-minute sessions with 
a couple minutes in between for partici-

pants to rotate tables and presenters to 
catch their breath.  Handouts will be avail-
able at many, if not all, of the tables, so that 
meeting attendees can gain valuable infor-
mation not only from the three sessions 
they participate in, but from the other four 
sessions as well. 

All in all, there’s a wealth of valuable infor-
mation to be had at this month’s meeting—
not to mention a valuable opportunity to do 
some professional networking with Central 
Florida’s technical communicators of tomo r-
row. 

Don’t miss it, folks. 
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April Meeting: Progression on Job Search and Placement on the 
Docket for this Month’s Meeting  

TOPIC PRESENTER(S) DESCRIPTION 

Working with a Recruiter Chris Stubbs, CBA Search Associates How to prepare for and what to expect when you de-
cide to work with a professional recruiter. 

Job Search Tips Richard Phipps, CIBER, Inc. Steps everyone should consider when beginning a job 
search.  Specific resources that can and should be used 
for a job search will also be discussed. 

Contract Work and Freelanc-
ing 

Barbara Odom, Barbara Odom and As-
sociates, Inc., 
Janette Farnsworth, Scribe Tree 

What to expect if you decide to change your employment 
status to contract work.  How to prepare for and what to 
expect when you decide to become a freelancer. 

Networking and Getting Your 
Foot in the Door 

Cathi Balboa, Intuitive Information, Inc. 
Mike Murray, Lockheed Martin 

How to build and maintain an active network of re-
sources.  This discussion group will also review certain 
techniques that you can use to get your foot in the door 
so you will be considered for the next step. 

A Corporate Perspective Pat Reed-Reimer, AT&T 
W.C. Wiese, Lockheed Martin 

What is a company looking for in a technical communica-
tor?  Staffed by managers from Central Florida opera-
tions of two Fortune 500 companies who maintain a full-
time staff of technical communicators. 

Resumes, Cover Letters, and 
Portfolios 

Dan Voss, Lockheed Martin Polishing your resume, cover letter, and portfolio gets 
you the interview.  Practical tips for both conventional 
and online.  Time permitting “quick-look” reviews of re-
sumes and portfolios will be provided. 

Interviewing Patti Strandberg, Lockheed Martin Nailing the interview gets you the job.  Strategies advice 
and practical tips on effective interviewing. 
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Sun Mon Tue Wed Thu Fri Sat 

    1 2 3 

4 5 6 7 8 9 10 

11 12 13 14 15 16 17 

18 19 20 21 22 23 24 

25 26 27 28 29 30 31 

May 2003May 2003   

The Melissa Pellegrin Memorial Scholarship 
Fund was founded to honor and preserve the 
memory and generous spirit of a valued friend 
and professional colleague, Melissa Pellegrin. 
She was a 1994 graduate of the University of 
Central Florida (UCF) and a member of the 
STC's Orlando Chapter.  

Melissa was an exceptional student who earned 
an STC undergraduate scholarship. After 
graduation she served on the Orlando Chapter's 
Education Committee. Melissa's a commitment 
to excellence was evident in the quality of her 
academic and professional work. She shared her 
enthusiasm in many ways, including profes-
sional presentations at conferences and meet-
ings. She was employed as a technical commu-
nicator with The Technical Resource Connec-

tion Inc., in Tampa, until her untimely death in 
April 1997.  

The Melissa Pellegrin Memorial Scholarship 
Fund was officially dedicated on October 3, 
1997 during the Trends '97 Conference, hosted 
by the Orlando Chapter of the STC. The fund 
provides scholarships and awards to selected 
outstanding undergraduates and graduate stu-
dents at UCF.  

At our next meeting, select students will be 
honored with a certificate and a check from the 
scholarship fund.  These students will con-
tinue a tradition of excellence in technical com-
munication and have their names engraved on  
a plaque with all past scholarship recipients at 
UCF. 

April Meeting: Melissa Pellegrin Scholarship Awards 
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All  STC monthly meetings are 
held at 6:30 p.m. at the Winter 
Park Civic Center unless other-
wise specified. 

STC 
Monthly 
Meeting 

Administra-
tive Council 
Meeting 

Honoring Melissa’s 
Memory 
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Web Site: www.stc-orlando.org 
 
Mailing Address:     STC Orlando 
                                P.O. Box 540444 
                                Orlando, Florida 
                                32854-0444 

O R L A N D O  C H A P T E R  S T C  Relay For Life: Remembering Friends and Family 
by Christina Payne 

Contact Us 
 
President:               Mike Murray                                          Hospitality & Membership Mgr.:         Barbara Odom       
                                407 306-4681                                                                                                       407 831-5820        
                                mike.murray@lmco.com                                                                                     BCOdom@aol.com 
 
Vice President:       Bob Shydo                                             Education Committee Manager:         Dan Voss 
                                407 302-2735                                                                                                       407 356-6508 
                                bob@intuitive-info.com                                                                                      daniel.w.voss@lmco.com 
 
Secretary:               David Coverston                                  E-mail List Administrator:                    Dan Jones 
                                407 551-3444                                                                                                       407 823-5160 
                                Dcoverston@paysys.com                                                                                  djones@ucf.edu 
 
Treasurer:               Karen Lane                                            Employment  Manager:                       Richard Phipps 
                                407 421-7795                                                                                                       407 682-1300 
                                klane@klane.com                                                                                                rphipps@ciber.com 
 
Past President:      W.C. Wiese                                             Co-Webmasters:                                   Jon Kessler                                             
                                407 356-4792                                                                                                       407 992-8005 
                                william.c.wiese@meadsintl.com                                                                          jkessler@csisoft.com 
 
Newsletter Editor: Christina Payne                                                                                                    Sharon Wissert 
                                407 306-6589                                                                                                       407 365-1396 
                                christina.l.payne@lmco.com                                                                              skw@cfl.rr.com                      
                                 

Chapter Meeting 
Schedule 
• April 22- Em-

ployment Pro-
gression and 
Scholarship 
Awards 

• May 27- Panel 
Discussion on 
Help 

• June 24-  Year-
end Banquet 

On Friday, April 11, 2003, Lockheed Martin 
Enterprise Information Systems (EIS) partici-
pated in the American Cancer Society’s Re-
lay For Life event held at Timber Creek High 
School in Avalon Park.  When I first heard 
about this fundraiser for 
cancer research, I knew 
that I wanted to volun-
teer my time, and of 
course, money.  With my 
heavy workload, I was 
unable to make it to the 
weekly planning meet-
ings held at our facility.  
However, I did manage to 
raise over $400 within a 
few days of the event!  

To help raise money for 
the event, I enlisted a few friends to walk 
and contacted co-workers, friends, and fam-
ily members for donations.  I was impressed 
and touched by everyone’s willingness to 
give to this cause.  This was a deeply per-
sonal and emotional event and I wanted to 
especially thank fellow STC members Bob 

Shydo, Dan Voss, and Mike Murray for their 
donations. 

I am sure there were other STC members that at-
tended or supported the Relay for Life, but for 
those that didn’t make it out this year, I encour-

age you to take part in the 
event next year.  The enter-
tainment was wonderful and 
the weather was perfect.  The 
sense of community, as we all 
rallied together, gave those 
suffering from cancer the 
hope that we are all united in 
trying to find a cure.   

From my own perspective, I 
feel that fundraisers like these 
become more personal as we 

learn of more loved ones who have fought or are 
fighting cancer.  The event also serves as an op-
portunity to pay tribute and remember the loved 
ones we have lost and to confirm our promise to 
friends and family members that we will be there 
to support them through their battle against can-
cer.   

Christina Payne and  
Miguel Valecillos at the Lockheed 

Martin Relay for Life tent. 
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